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1 RADIOPRO DISPATCH OVERVIEW  

RadioPro Dispatch offers a console-type solution for applications requiring connection to many MOTOTRBO  or 

NEXEDGE radios (control stations). It is designed with an intuitive user interface to minimize learning time and 

maximize a user’s efficiency. A host of accessories are available to implement an enterprise solution; including 

desk microphones, headsets, footswitches, and touch screens – all with PTT capabilities. Depending on the 

license purchased, features of RadioPro Dispatch may include: 

• Voice Dispatching for 1 to 40 Talk Groups 

• GPS Mapping of radio subscriber units 

• Text Messaging 

• Voice and Event Logging and Playback 

• Telemetry 

A system may have a mixture of Dispatch and Talk Clients, as well as Mobile apps running on iOS and Android 

devices.  Dispatch Clients, Talk Clients, and Mobile apps can be scattered among different locations, or centrally 

located.  

One or more IP Gateways interface the radio system to an IP network, ensuring easy wide-area deployment 

without configuring server PCs.  One IP Gateway is required for each Talk Group to be communicated with 

simultaneously.  The IP Gateways and control station radios can be scattered among different locations, or 

centrally located.   
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2 QUICK STARTUP 

2.1 Using the RadioPro System 

To use the RadioPro Dispatch client, Install the  RadioPro Dispatch software to your PC. 

Once installed, double-click the RadioPro Dispatch icon on the PCs desktop.     

 When the Login window is displayed as shown at right, choose a User from 

the drop-down list, and then click the Login button.  

This should load the CTI Products owned Demo system based in Cincinnati 

Ohio. The Demo system may be used for training and testing purposes only. 

 

2.1.1 Demo Example 

When the RadioPro Dispatch Client opens, the Main Window will be displayed with various tabbed panels: 

• Radio Controllers (voice)  

• Map  

• Subscribers  

• Recent History  

• Text Messaging  

• Geo-fence Alerts 

• Missed Calls 

These tabbed panels can be docked in alternate positions or hidden completely if not needed.  The Main 

Window on the PC monitor may look different than the example shown below, depending on how your System 

Administrator configured the tabbed panels within the RadioPro Dispatch client user interface.  
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RadioPro Dispatch  User Guide 

 8  

2.2 Building a Custom Configuration 

To get started using a system with your own hardware and licenses, you will have to build a new system 
configured with your specific Gateway, network and system details using the following Steps: 
 

1. Install the RadioPro Dispatch Software on your PC device. 
 

2. Load the license Key-file for the Dispatch software that was shipped with your system. 
 

3. Use the ICU.exe application to locate and configure the RadioPro gateway(s) for your local IP network. 
 

4. Click ‘File’ then ‘New’ to open a virgin system template and begin configuring  The Dispatch Layout; 
See more details on Page 14. 
 

5. Add each Gateway that was configured in the ICU for your system, using the  ‘Options’ > ‘Manage IP 
Gateways List. See page 34 for additional details. 
 

6. Add the appropriateAdding a Tab Page as discussed on page 14 to support the features  you are 
licensed to use with your system 

.e.g Voice page type for communication and GPS Page type for subscriber tracking …etc 
 

7. From within each added Tab Page you can now add configure the appropriate selection of Radio Panel 
controllers and Maps as permitted by your licensing. 
 

8. Save you system with an appropriate name to a publicly accessible location on the local PC. 
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3 TOOLBAR 

The Toolbar contains tools for Audio levels, as well as standard and custom buttons as described below.  

3.1 Audio Controls 

3.1.1 Initial Settings 

Use the audio sliders on the Toolbar to adjust audio levels for Mic transmit audio, 

Select receive audio and Unselect receive audio.   If your dispatch is connected to 

multiple gateways, only one gateway will be considered “selected” at a time.  The 

“selected” gateway will be colored yellow in its title bar.  The “Select” and “Unselect” sliders allow you to 

program a different volume based upon whether the incoming audio transmission is from the selected radio or 

is coming from one of the other unselected radios.  A Volume Unit (VU) meter is located next to the Mic audio 

slider to visually express the loudness of outgoing transmissions.  

Begin by selecting an Audio Preset from the Options Menu.  Audio Presets may 

be configured by the System Administrator for various audio devices including 

speakers, microphones, and headsets.  A “default” preset uses the PCs default 

selection for microphone and speakers.  

Make initial volume settings as follows: 

• In the Toolbar, adjust the Mic and Select sliders to 100%, and the Unselect slider to 

50%. 

• In each Radio Controller, click on the speaker tool, and adjust 

the slider to 100%. 

• If desk speakers are installed for receive audio, use the control 

knob on the desk speakers to adjust the overall speaker volume 

to 50%.   
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3.1.2 Mic Audio Transmit Slider and VU Meter 

Various microphones and headsets may be connected to the Dispatch PC for transmitting audio.  Only one 

active device can be used at any given time, determined by the selection in Options . . . Audio Presets. 

While clicking on a PTT button, speak into the microphone or headset and view the microphone audio level 

displayed on the Volume Unit (VU) meter (located on the Toolbar next to the Mic slider).  For optimum sound 

level, the meter should reach into the yellow area 10-50% of the duration.  The red area indicates clipping and 

distortion and should be avoided.  To adjust Mic volume level, click and drag the slider to the desired level.   

If a headset is being used, it may also have a volume adjustment. 

 

3.1.3 System Administrator Adjustment 

If a wider range of adjustment is needed, the System Administrator can 

adjust the microphone transmit audio level by right-clicking the speaker 

tool in the Windows system tray to display the Operating System Volume 

Mixer.   

• For Windows 8 and Windows 7, choose Recording Devices from the drop-down list.  

On the Recording tab, double-click the appropriate microphone, and then adjust the 

slider on the Levels tab. 

• For Windows XP, choose Open Volume Control.  In the Master Volume window, 

choose Properties from the Options menu.  In the Mixer Device list, select the 

appropriate microphone, and then click the OK button.  Adjust the slider to 100%. 
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3.1.4 Select and Unselect Audio Sliders 

One or more Radio Controllers can be “Selected” to have their audio received at the “Select” audio level, 

determined by the Select volume slider that is located in the Toolbar. 

To adjust Select or Unselect volume levels, click and drag the slider to the desired level.  Typically, the Select 

audio will be set at 100%, and the Unselect audio will be set at a value less than 100%. 

There are various ways to adjust incoming volume: 

• For any Radio Controller, click on the speaker tool    in the Radio Controller 

window header to show the volume slider for this radio channel.  Click and drag the 

slider to the desired level.  Double-click the speaker tool to toggle between mute and 

un-mute states. 

• To adjust “Select” and “Unselect” volume levels, use the Select or Unselect volume 

sliders on the Toolbar.  Click and drag the slider to the desired level. 

• If desk speakers are installed, use the Volume knob to adjust the speaker volume. 

 

3.1.5 System Administrator Adjustment 

If a wider range of adjustment is needed, the System Administrator can adjust the overall speaker volume by 

right-clicking the speaker tool in the Windows system tray, then clicking on 

Playback Devices to display the Operating System Volume Mixer.  The 

volume sliders should normally be set to 100%.   

 

The Toolbar can hold Toolbar Buttons that have been configured by your System Administrator.  

Toolbar Buttons can be defined for a wide range of actions and will have custom labels. A few of the 

more common uses for Toolbar Buttons are described below. 

3.1.6 Call Selected 

A Toolbar Button may be configured to make a call to one or more “Selected” Talk Groups.  “Select” a 

single Talk Group by clicking on the header portion of the Radio Controller.  “Select” multiple Talk 

Groups by holding down the Ctrl key on the keyboard and clicking on the header portion of various 

Radio Controllers.  (Note that the Radio Controller header will be shaded yellow when “Selected”.)  

To make a voice call to the “Selected” channel(s), click and hold the Call Selected Toolbar Button while 

speaking into the microphone.  If a touchscreen is installed, this can also be done by touching and holding the 

button on the touch screen.  In addition, a pushbutton on a desk microphone or footswitch may have been 

configured to activate the “Call Selected” function.  
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3.1.7 All Call 

A Toolbar Button may be configured to make a call to all radio subscribers in the radio system.  To 

initiate an All Call to every subscriber in the radio system, click and hold the All Call Toolbar Button 

while speaking into a microphone or headset.  All Call voice messages are queued in memory, and 

then sent when a channel is clear.  This ensures that every subscriber receives the entire message. If a 

touchscreen is installed, this can also be done by touching and holding the button on the touch screen.  

  

3.1.8 All Emergency  

A Toolbar Button may be configured to activate the emergency tone on each radio in the system.   

 

 

3.2 Quick Map, Archive, and Reports Toolbar Buttons 

The Toolbar contains toolbar buttons for Quick Map, Archive, and Reports.  

Clicking one of these buttons will open a window to view information for those 

functions.  The Archive and Reports buttons may be grayed out and unavailable if 

History Logging has not been configured. See later in this document for details on 

these buttons. 

 

3.3 Toolbar Buttons for Custom Actions 

The Toolbar can hold Toolbar Buttons that have been configured by your System Administrator.  

Toolbar Buttons can be configured for a wide range of actions and will have custom labels.  

 

3.4 Disk Storage Caution Symbol 

RadioPro Dispatch continuously calculates the remaining amount of storage on the hard disk partition 

specified by the System Administrator for logging of Voice files, Text Messages, and other radio system 

events.  If less than two weeks of storage remains on the hard disk partition, a caution symbol will be 

displayed on the right side of the Main Toolbar.  If the hard disk partition becomes full, logging will no 

longer take place.  To allow continued logging, the System Administrator must remove unwanted files, or 

transfer them to permanent storage media. 
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3.5 Emergency Events  

3.5.1 Emergency  Indication 

When an emergency is initiated from a subscriber, the following indications help to quickly identify the channel 

and subscriber: 

• An Emergency Notification Tool is placed in the Main Toolbar.  This tool can be used to 

respond to the radio user that initiated the emergency.  It is also used to clear the 

emergency.  

• A red emergency icon  is visible in the Subscribers Window, next to the subscriber who 

initiated the emergency. 

• An audio alarm signal is activated. 

 

3.5.2 Operation 

The following actions can be used to acknowledge an emergency condition by clicking on the emergency tool 

being displayed in the Toolbar: 

• PTT – The top portion of the Emergency Notification Tool in the Toolbar can be used as 

a PTT to return a private call to the radio user that initiated the emergency.  Clicking on 

this button will silence the audio alarm signal for this emergency, and then place a 

private call to the radio that initiated the emergency.  

• Options – The bottom portion of the Emergency Notification Tool can be used 

to remove the visual and audio indicators for this emergency.  

 

3.5.3 Clearing an Emergency State of a Control Station Radio 

The System Administrator can configure the way in which an emergency state is cleared in the Control Station 

radio.  One option will clear the emergency state when Remove is selected from the emergency drop-down list 

as shown above. 

Another method requires that the Control Station radio be manually reset after an Emergency has been 

Removed (cleared). This is accomplished by using the following steps: 

1. From the Options menu, choose Manage IP Gateways. 

2. Right-click the radio where the emergency state must be cleared, and then choose Restart Radio. 
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4 THE DISPATCH LAYOUT 

The RadioPro Dispatch GUI is inspired by a panelized styling concept referred to as the Layout.  This allows for 
very configurable layouts that accommodate various user preferences and yet maintains desirable ease of use 
operation.  Each panel is identified and configured  as individual ‘Tabs’ that complement the distinctive 
functions and features of each other. The ‘Tabs’ maybe added and removed as needed, if that feature is 
permitted by the purchased license options. 
 

4.1 Creating a New Layout 

Before the RadioPro solution can be functionally deployed, at least one ‘Tab page’ must be created. 
However, be aware that the functionality of most options is license dependent; therefore, every feature 
may not be available in all cases. 

4.1.1 File > New  

This will provide you with a template base to begin configuring your system.  
You may add and configure the various Panel options as required functions 
or specific preferences dictate. 

 

4.1.2 Adding a Tab Page 

The System Administrator  SA has full elevation rights to configure any licensed  
system feature during the creation or editing phase of the Dispatch layout design. 
 
 To ADD a page , Click the green  Icon  then choose from one of the three types 
 of page option available:   
 

4.1.3 Voice Tab(s)  

Voice Tab   This allows the SA to create a Tab page where one or more Virtual Radio panels can  
be added and used to remotely monitor and operate each control station radio that is connected to  
a gateway.  

Voice tabs contain Virtual Radio Control Panels that are 

customized by your System Administrator to show optional 

features such as radio programmable buttons and status 

information. Radio Control Panels can also be customized 

with border colors to help organize and highlight certain 

radio Talk Groups. 
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4.1.4 GPS MAP Tab(s) 

Adding  this Tab allows the System Administrator(SA) to create a page, where map types and views can 
be configured for displaying subscriber GPS positions. This page requires and supports the use of the 
GPS license option. 

GPS map tabs are configured during installation and occupy a space on the desktop determined by the 

SA.  They can be configured to be docked to the Main Window using tabs or can be configured to be 

un-docked in separate windows. The GPS map tab shown below shows the following features: 

• Geo-fence – “Polygon 1” outlined in green is a geo-fence that defines the city limits. 

• Geo-fence – “Route 1” outlined in pink is a geo-fence that defines a route. 

• Location – A green circle denotes the current location for radio subscriber 9083. 

• Trail Crumbs – The blue line is the route taken by this subscriber.  Hover the mouse over any 

grey circle on this route to display the date and time that this subscriber was at this location. 

• Subscriber Status Bar – Information is displayed at the bottom of the GPS map tab for the 

selected subscriber including current speed (or duration of stop), street address, and time since 

last GPS update. 
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4.1.5 Subscriber Grid Tab(s) 

Adding  this Tab allows the System Administrator (SA) to create a page, that will copy all the subscribers  
defined within a selected contacts list and display to a ‘Grid View’ for faster and easier interactions. 

Subscriber Grid tabs maybe  configured Pre or Post to the system installation. The Grid contacts copied 

from the selected contact list are populated sequentially based on their IDs, to the Grid Tab page.  The 

Grid Tabs are docked to the Main Window by default but can be undocked to a separate window if 

preferred. A  configured Grid tab is shown below. 

 

You can initiate a private call to the 

selected contact by clicking on one of 

the Grid names. 

 

A Right click will provide additional  

options for that contact. 
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5 MAKING & RECEIVING VOICE CALLS  

To initiate a voice call to an entire radio Talk Group, use the PTT button on a Radio 

Controller Window. Use the PC’s mouse to click and hold the PPT while speaking into a 

microphone or headset.  If a touchscreen is installed, touch and hold the PTT.  In 

addition, a PTT pushbutton on a desk microphone or footswitch may have been 

configured to activate a call to a particular Talk Group. 

 

5.1.1 Transmit Indicators 

When a PTT is activated on a Radio Controller, the following indications are visible: 

• The PTT button background color changes to red. 

• The Transmitting icon  is displayed. 

• The icon for either a private call    or group call    is displayed. 

• Text is displayed to indicate the Radio ID or Group ID as well as the alias name of the subscriber 

or group. 

 

5.1.1.1 Adjusting Transmit Volume 

Use the Mic audio slider on the Toolbar to adjust the transmitted audio.  A VU 

meter is located next to the Mic audio slider to visually determine the loudness of 

outgoing transmissions.  
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Selected 

Controller 

‘receiving’ 

an IP 

Client Call. 

Unselected 

Controller 

‘receiving’ 

RF Subscriber 

Call. 

5.1.2 Receive Indicators 

When a valid call is received and decoded by the Control station radio, the Radio Panel  

display will show the ID of the subscriber and you will automatically hear that call audio 

through the speakers designated for either Selected or Unselect audio, depending  on if 

the Receiving  Panel is the selected  radio or one in the unselected group. 

 

When a call is received, the Radio Controller will indicate the following:  

• The Receiving icon   is displayed. 

• The icon for either a private call    or group call 

    is displayed. 

• Text is displayed to indicate the Radio ID or Group ID 

as well as the alias name of the subscriber or group.  

 

5.1.2.1 Adjusting the Receive Volume 

Click the speaker tool in the header portion of the Radio Controller to make an 

adjustment to the receive-audio level for a Talk Group.  Double-click the speaker  

tool to switch the audio level between muted and un-muted. 

 

5.1.3 Patching 

If enabled by the System Administrator, the Patch button will be enabled on the header 

of the Radio Controller Panel, allowing the creation of a patch between a pair of Talk 

Groups.  When a patch is created, both transmit and receive voice traffic will be shared 

by the paired Talk Groups.  In addition, a voice call placed by the dispatcher to one of 

the patched Talk Groups will be heard by both Talk Groups in the patch. 

To create a patch, click the   button (until it is highlighted as shown at right) on the 

two Radio Controllers that are to be patched together.  Patching is limited to a single pair  

of Talk Groups for the entire RadioPro system.   

If this option is enabled for Radio Controllers on other Dispatch clients, patch status will  

be displayed on these other clients.  
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5.1.4 Connection Status Indicators 

5.1.4.1 Radio connected 

When an IP Gateway successfully communicates with the Control Station radio, the 

Radio Controller panel will show the Gateway name and the configured soft button 

features to operate that radio will become visible. 

 

5.1.4.2 Radio Disconnected 

When an IP Gateway cannot communicate with the connected Control Station radio, the 

Radio Controller background is shaded dark gray, and “Radio Disconnected” is displayed. 

 

 

5.1.4.3 Can’t Connect to Gateway 

When the RadioPro Dispatch client cannot communicate with the connected IP 

Gateway, the Radio Controller background is shaded dark gray, and “Can’t connect to 

Gateway” is displayed. 
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5.1.5 Subscriber Details 

Select a subscriber, either by clicking a subscriber icon on the map or by choosing a subscriber in the 

Subscribers panel. Note that the current position of the selected subscriber is a green circle to indicate 

movement, or a red stop sign to indicate stopped. Notice that Trail Crumbs are shown for this selected 

subscriber for the last 30 minutes. (This time is configurable by the System Administrator using the Edit mode.) 

Hover over any waypoint (grey circle) on a subscriber’s route to show date, time, and speed at this point. 

View detailed information for this subscriber in the Subscriber Status Bar located at the bottom of the map.  

Information will include street address, rate of travel (or stopped time), and time since last GPS update. 

Click the  icon to open Google Street View to see the features that a subscriber could see at this location. 

Click the  icon to copy the information in the Subscriber Status Bar to the Windows Clipboard.  This 

information may then be pasted into other applications, such as email, text messaging, and Microsoft Office. 

 

5.1.6 Subscriber Actions 

5.1.6.1  Select a Subscriber 

Select a subscriber, either by clicking on an icon on the map or a subscriber in the Subscribers tab. 

 

5.1.6.2 Make a Private Call 

Use the PTT button at the bottom of the Subscribers tab to make a private call to this subscriber. 

 

5.1.6.3 Send a Text Message 

While a subscriber is selected, the Text tab can be used to send a private text message to this selected 

subscriber. 
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5.1.7 Toolbar buttons 

5.1.7.1 Subscriber Visibility Button 

Click the Visibility  button to select which subscribers should be visible on 

the selected map.  A window will be displayed that looks very similar to the 

Subscribers tab.  However, the Visible Subscribers tab adds control for visibility.  

Visibility may be toggled on and off individually by clicking a subscriber’s 

visibility icon as shown at right, or as a group by clicking the icon for that 

group. Three versions of this symbol will indicate visiblity as indicated below: 

5.1.7.2 Center (Subscribers on Map) Button 

Click the Center  button to zoom and reposition the map in order to show all visible subscribers on the 

selected map. 

5.1.7.3 Follow (the Visible Subscribers) Button 

Click the Follow  button to keep the selected subscriber centered in the selected map. 

5.1.7.4 Map Presets Button 

Click the top portion of the Map Presets  button to return the selected map to the indicated preset as 

configured by the System Administrator.  

Click the arrow on the lower portion of this button to list other presets that have been 

configured by the System Administrator.  Click on one of the items in the list to switch the 

selected map to a new preset. 

 

  

Symbol Groups Subscribers 

 All members are 

visible 

Subscriber is visible 

 Some members 

are visible 

 

 No members are 

visible 

Subscriber is not visible 
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5.1.7.5 Map Type Button 

Click the Map Type  button to list Map Types that have been enabled by the System Administrator.  

5.2 More Map Features 

Right-click a point on the GPS map to display the menu shown at right. 

 

 

5.2.1 Place Markers 

Choose Add Place Marker to add a marker to the map.  Using the Add Place 

Marker window, customize the marker for marker Display Name, Radius, and 

color.  A marker with the chosen parameters will be shown on the GPS map. 

Choose Clear Place Markers to remove all Place Markers from this GPS map. 

 

5.2.2 Quick Reports 

When a subscriber is selected, choose Quick Reports to show the 

menu options for reports for this subscriber.  Available reports include 

Position Report and Stopped Report. 
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5.2.3 What’s this Address? (& Nearest Radio) 

Choose What’s this address? to open the Address 

Lookup window shown at right.  The address will be 

listed in the window along with the nearest radio 

subscribers in order of distance. 

 

 

 

 

Select a subscriber from the list in the Address 

Lookup window to graphically show the distance 

from the selected point on the GPS map to the 

selected subscriber. 

 

 

 

 

 

5.2.4 Find Address (& Nearest Radio) 

Choose Find Address if you wish to enter a known address into the Address Lookup window.  After entering 

the address, click the   button.  The nearest radio subscribers will be listed in order of distance.  Select a 

subscriber from the list to graphically show the distance from the selected point on the GPS map to the 

selected subscriber. 
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6 SUBSCRIBERS PANEL 

The Subscribers panel lists radio subscriber and subscriber groups.  

In addition to the Radio ID, the list may also contain alias names for 

radio subscribers.   

The Subscribers tab may also contain buttons to perform specific 

functions as described below.   

 

 

 

6.1 Making a Group or Private Call 

To initiate a group or private voice call using the Subscribers tab, select a Group or 

Private subscriber, and then click and hold the PTT button at the bottom of this window 

while speaking into a microphone or headset.  Alternatively, if a touchscreen is installed, 

touch and hold the PTT button on the screen.  
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6.2 Subscriber Action Buttons 

Additional subscriber actions are available at the bottom of the Subscribers tab, including the following. 

 

6.2.1 GPS Locate 

Click the GPS Locate button to locate the selected subscriber.  

After clicking this button, the Quick Map icon on the Toolbar will 

display a count-down to locate the radio subscriber.  If a GPS 

response message is received from the subscriber radio, the Quick Map window will open, and 

the subscriber will be positioned at the center of the map.   

 

6.2.2 Radio Check 

Click the Radio Check button to determine if a 

radio is accessible, and the talk group or channel 

currently being used. A Check Radio window will 

be displayed to indicate the subscriber’s availability. 

 

6.2.3 Call Alert 

Click the Call Alert button to activate the alert tone on a subscriber radio.  The 

alert tone will sound on the subscriber radio until the user responds to it. 

 

6.2.4 Remote Monitor 

Click the Remote Monitor button to remotely key-up a subscriber radio.  This 

function must be enabled in the subscriber radio to allow this function.  If function 

is enabled, the radio will key-up for a period of time configured in the radio. 

 

6.2.5 Remote Enable and Disable 

Click the Remote Disable button to power down a subscriber radio and cause it to 

be unable to power up.  Click the Remote Enable button to remove this restriction 

for a subscriber radio. 
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6.3 Searching for a Subscriber 

Click the    tool near the top of the Subscribers tab to show the Search box.  Type 

characters in the Search box for a subscriber radio ID or an alias name.  Click the    

tool to clear the typed characters from the Search box. 

 

 

6.4 Sorting the Subscriber List 

Click the    tool near the top of the Subscribers tab to sort the subscriber list 

numerically by Radio ID.  Click it again to sort in reverse order.  Note that the button 

changes to   and indicates a reverse order sort.   

Click the    button to show a list of sorting options; “Sort by ID” and “Sort by 

Name”.  When “Sort by Name” is selected, the sort button changes to  , or   for 

reverse sorting. 
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7 GEO-FENCE ALERTS PANEL 

One or more Geo-fences may exist in order to check various conditions of radio subscribers.  One or more 

conditions may exist for each geo-fence.  The conditions can apply to All Subscribers or Specific Subscribers.  

When a Geo-fence condition is met for a radio subscriber, an event is logged in the database.  In addition, Geo-

fence conditions that are true are listed in the Geo-Fence Alerts panel.  A typical listing of Geo-fence Alerts is 

shown below. 
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1. CALL BOX  

 

8 RECENT HISTORY PANEL 

The Recent History panel includes the most recent events of the radio 

system, including : 

• Two-way voice calls  

• Interconnected telephone calls,  

• Text messages,  

• Call alerts, 

• and emergencies.  

The number of events displayed in this window can be configured by your System Administrator, to list 

between 1 and 500. 

8.1 Replay Audio 

To replay audio, click a voice event (indicated by a speaker tool), and then click the Play  button at the top 

of this window.  If the Play button    and the Note button   are grayed-out, the selected audio event has 

not been logged to the hard disk because History Logging has not been configured.  In this case, the System 

Administrator must configure History Logging using the Dispatch Settings window, found in the Options 

menu.  

 

An alternative method for replaying audio is to double-click a voice event that appears in the Recent History 

tab.    

8.2 Diagnosing Volume Issues 

To diagnose playback volume issues, click an incoming radio transmission voice event.  The volume of the 

selected transmissions will be shown as a percentage in the Volume column.  

Press the Volume Info button  to get more information about the volume of this transmission. 

 

Total call 

volume 
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The Volume Info window shows detailed information for how a radio transmissions volume is determined.  

              

Audio Source and Destination: 

• The Audio source, Output device, and Output speaker are 

displayed at the top of the window.  These settings are 

configurable by an administrator.  The settings are 

available from the Audio Configuration screen in Edit 

mode under Options... Audio Presets. 

Volume Components: 

• The Radio resource volume can be adjusted per radio 

using the audio volume  button in the upper right 

corner of the radio controller. 

• The Select volume is the volume of radio transmissions 

coming from the selected radio controller.  When a radio 

controller is selected, it is shaded yellow.  To 

change the Select volume, use the Select slider.  

• The Unselect volume is the volume of radio traffic coming from any unselected 

radio controllers.  To change the Unselect volume adjust the Unselect slider.  

• The Intercom volume is the volume control for other Dispatch clients.  There is an Intercom 

volume control and several configuration options that will determine this value.  These options 

Audio Source and Destination 

Volume Components 

Total Call Volume 

RadioPro Dispatch 

GW Selected GW Unselected 

IP Gateway 

2-way radio 

connected to 

our IP gateway 

PC Speaker 

Radio Source 

Radio transmission 

from mobile or 

portable radio. 

Audio Path for a Radio Source 
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can be configured by an administrator.  The Intercom settings can be accessed from the Audio 

Configuration screen in Edit mode under Options... Audio Presets. 

   

Total Call Volume: 

• The Total volume for this call is the aggregate of all the settings in the volume components 

section.  This value is also displayed in the Volume column of the Recent History panel.  

GW Selected GW Unselected 

RadioPro IP Gateway 

                      Intercom 

                    Audio uses  

                select/unselect 

                       volume? 

Yes 

No 

     Intercom 

   Audio uses  

radio talkgroup 

      volume? 

Yes 

No 

Intercom Volume 

PC Speaker 

IP Client 

RadioPro 

Dispatch 

Audio Path for an Intercom Source 
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8.3 Notes and Sorting 

Add a note to an event by clicking the   button to open the Note window.  Only the last note added for an 

event will be displayed in the Recent History window. 

The events in the Recent History tab can be sorted by clicking on one of the headings. 

9 MISSED CALLS PANEL 

The Missed Calls panel will display a list of incoming private Radio 

calls that have not been responded to from the Dispatcher with a 

return private call.  When a private call is made from the Dispatcher 

to a subscriber in this list, the subscriber will be removed from the 

list. 

Additional functions are available from the Missed Calls panel: 

• To disable the missed call panel, press the Enabled 

 label and it will switch to disabled and the missed call panel will turn grey.  When 

disabled, missed radio transmissions will not be recorded in the missed call panel window. 

• To re-enable the missed call panel, press the Disabled  label and it will switch to 

enabled and the missed call panel will turn white again. 

• To cancel a missed call that is listed, select a subscriber from the Missed Calls list and then 

click the Cancel Missed Call button. 

• To play the last incoming audio from a subscriber, select a subscriber from the Missed Calls list 

and then click the Play Audio button. 

• To return a private call to a subscriber, select the subscriber from the Missed Calls list and 

then click the Call button. 
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10 MESSAGES PANEL 

Use the Messages panel to send and receive text messages between this PC and radio users.  It is designed to 

function similar to messaging found on a smart mobile device.  Two views are available. 

10.1 Main Message View 

Main Message View is the default view and shows the last conversation for each radio subscriber, with the 

most current conversation at the top.   

A conversation can be started by clicking the  button.  In the New 

Text Message box, choose one or more recipients, and choose an option 

for When to send from the drop-down list.  Finally, type the message, 

and then click the  button.  The new message will be displayed in 

the Main Message View as a conversation. Message status displayed 

along with the message include: 

• Sending 

• Pending 

• No acknowledgement 

A message that was sent successfully will display the elapsed time from being sent. 

10.2 Conversation View 

Click one of the conversations on the Main Message View to see the details of a 

Conversation.  In the Conversation View, all messages with the selected radio or radio 

group will be displayed, along with status information for each message.  

Use the  button to go back to the Main Message View. 

To add a reply to this conversion, type the reply into the Enter Message text box, and 

then press the  button. 
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11 MENUS 

11.1 File Menu 

11.1.1  Change User 

Click on Change User to open the Login window and allow another user to log 

into the system. 

 

11.1.2 Open 

Configuration files contain customized screen layouts that can be used for different users of the RadioPro 

Dispatch client software. Click on Open in the File menu to load a saved configuration file.   

 

11.1.3 Edit 

The Edit menu item is used by the System Administrator to customize the operation and screen layout of the 

RadioPro Dispatch client software. 

 

11.1.4 Exit 

Click on Exit in the File menu to exit the RadioPro Dispatch client. 
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11.2 Options Menu 

11.2.1 Manage IP Gateways 

The Manage IP Gateways window displays the status 

of connections to radio resources.  The settings in this 

window can be altered only by the System 

Administrator.   

11.2.2 Status Table 

Table headings in the Manage IP Gateways window is defined as follows: 

Address 

 IP Address assigned to IP Gateway, and Port Number. 

 
Name 

 Name assigned to IP Gateway. 

 
Gateway Status 

  Indicates “Connected” and firmware version of IP Gateway, or “Not Connected”. 

 

Radio Version 

Indicates firmware version of Radio if connected, or “Not Connected”. 

 

Pri/Sec 

  Selects between Primary or Secondary Addresses, and Auto for which ever one is available. 

 

Date / Time 

 Date and Time being used by IP Gateway. 

 

Record Option 

 When checked, allows logging of audio to the database. 

 

Audio Option 

 When checked, allows audio to be heard for this IP Gateway. 

 

Text Option 

  When checked, this option allows text messaging for this IP Gateway. 
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11.2.3 Actions 

The following actions are available by right-clicking on an entry in the Status Table. 

• Restart Radio will restart the Control Station radio connected to the selected IP Gateway 

• Restart Gateway will restart the selected IP Gateway.  The Gateway Status will be indicated 

as “Not Connected” for approximately two minutes.  Following this period of restarting, verify 

that the IP Gateway and Radio indicate a proper connection status. 

11.2.4 System Problems Box 

The System Problems box at the bottom of the window will describe current system faults, such as 

unconnected Radio Resources and License limits. 

11.2.5 Audio Presets 

Audio Presets may be configured by the System Administrator for various audio devices including speakers, 

microphones, and headsets.  A “default” preset uses the PCs default selection for microphone and speakers.  All 

configured Audio Presets will be listed, with the selected preset indicated with a check mark. 

11.2.6 Update License 

When not in Edit mode, the Update License window can be viewed but cannot be 

altered. It will show the USB Key ID #, and licensed options.   

To export the license file for archiving to another location, click the Export button, 

and then choose a file name and location.  

11.2.7 Contacts 

Click on Contacts from the Options menu to open the Subscriber Contacts window.  This window can be 

used to add, delete, or edit alias names and other information related to a Radio ID. It can also be used to 

create groups of radio subscribers for better organization within the Subscribers window. This information will 

be displayed in the Subscribers tab. 

11.2.8 Editing the Contacts List 

Use the right side of the Subscriber Contacts window to make 

changes to contacts.  Click the  button to add a contact to 

the list. Click the    button to delete a contact from the list. 

This information will be displayed in the Subscribers tab. 

 

 

Table headings in this window are defined as follows: 

ID 

Subscriber Radio ID (digital channel) or MDC code (analog channel) 
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Type 

Subscriber type:  Digital Group, Digital Private, MDC Group (analog channel), or MDC Private 

(analog channel). 

Alias 

Alias name associated with a Subscriber Radio ID 

Assigned Channel 

“Automatic” (default normal mode) allows the system to dynamically assign an IP address of 

a Radio Resource.  Alternately, a Radio Resource may be permanently assigned to this 

Subscriber Radio ID using an IP Address and Port Number. 

11.2.9 Managing Groups 

Use the left side of the Subscriber Contacts window to make 

changes to Groups.  Click the  button to add a new Group. 

Click the    button to delete a Group.  Click the   button 

to edit a group’s name.  This information will be displayed in 

the Subscribers tab. 
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11.2.10 Saving the Contacts List 

Click the Save button to save changes to the Contacts and Groups.  Changes will be saved to a file named: 

   aliasTable.csv 

This CSV (Comma Separated Values) file can be viewed and 

edited directly using Microsoft Excel by using the link at the 

bottom left corner of the Subscriber Contacts window.  

When saving this file from Microsoft Excel, be certain to save it 

as a CSV file. 
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11.3 Help Menu 

Click the help menu for additional  application 

Information and support 

 

11.3.1 About 

Click on About in the Help menu to display Part Number 

and Version of the RadioPro Dispatch client. 

 

 

11.3.2  

Remote Support 

If difficulties are experienced with RadioPro Dispatch  

and the console PC has Internet access, use this option 

to assist our Technical Support department in remotely 

 logging into the PC. 

 

11.3.3 Logs 

This feature is intended for use by CTI personnel only.  

 

 

 

11.3.4 ARS / GPS Events 

This feature is intended for by CTI personnel only.  

 

 

 

11.3.5 ARS / GPS Events 

This feature is intended for by CTI personnel only.  
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12 QUICK MAP  

Click the Quick Map button    on the Toolbar to open the Quick Map GPS window. An example Quick Map 

is shown below. 

 

12.1 Selected Subscriber 

One subscriber may be “Selected” by clicking on its label.  When a subscriber is “Selected”, its label (including 

radio ID or alias name) will be emphasized, and the following actions are available: 

• Make a Private call to the subscriber. (See PTT Tool below.)  

• Send a Private Text Message to the subscriber/ (See Text Messaging Tool below.) 

• View the Snap-to-Road route traveled by the subscriber.  

• View Timestamp at a location and Speed of Subscriber by hovering over any Trail Crumb. 

Selected 

Subscriber 

 

 

 

 

 

 

Unselected 

Subscriber 

 

Quick Map Tool 

Bar 

 

 

 

 

 

 

 

 

 

 

 

Geo-fence 
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12.2 Call Boxes 

Your radio system may include 2-way radio call boxes.  2-way radio call boxes work with Dispatch in much the 

same way as other 2-way radios on your system except they appear on your GPS map as a stationary square. 

 

Call box displayed on GPS map. 

 

Subscriber grids dedicated to 

call box subscribers. 
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12.3 Toolbar 

The Toolbar for the GPS Window contains tools for Zooming, Map Type, Map Presets, GPS Locate, Text 

Messaging, and PTT. 

 

12.3.1 Zoom Tools 

Use the Zoom In and Zoom Out tools, or 

optionally, use the mouse scroll wheel for 

zooming.  

 

12.3.2 Map Type Tool 

Your System Administrator may have configured 

optional Map Types to be available.  Click this 

tool to display these optional Map Types 

including Roads, Satellite, and Hybrid. 

 

12.3.3 Map Presets Tool 

Your System Administrator may have configured 

optional Map Presets in order to quickly jump to 

various geographic locations with a 

predetermined zoom setting.  Multiple Map Presets may be configured. 
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12.3.4 GPS Locate Tool 

This tool duplicates the function of the GPS 

Locate button located in the Subscribers tab.  

Before clicking this tool, select a Subscriber from 

the Subscriber List.  Click the GPS Locate button to locate the selected subscriber.  After clicking this button, 

the GPS Locate tool will change to the Locating tool, with information relating to the selected subscriber. 

When the subscriber is located, the GPS window will open, and the subscriber will be positioned at the center 

of the GPS map.   

 

12.3.5 Text Messaging Tool 

Use this tool to send a text message to the 

subscriber selected on either the GPS Map 

Window, or in the Subscribers tab.  After 

clicking this tool, the Send Text Message 

window will be displayed as shown at right. 

 

 

12.3.6 PTT Tool 

Use this tool to make a private call to the 

subscriber selected on either the GPS Map 

Window, or in the Subscribers tab. Click and 

hold this tool for the duration of the call. 



RadioPro Dispatch  User Guide 

 43  

13 ARCHIVE VIEWER 

The Archive Viewer may be opened using either of the following methods: 

• To open the embedded version of the Archive Viewer from RadioPro Dispatch client, click the 

Archive tool    on the Toolbar.   

• During installation of RadioPro Dispatch, the stand-alone ArchiveViewer.exe is copied to the 

installation folder.  

From the folder: C:\Program Files (x86)\RadioPro\  

copy the file named: ArchiveViewer.exe 

to a PC that requires access to the RadioPro database. 

 

The Archive Viewer has major sections indicated below; Search Filters, Search Results, Event Detail, and Page 

Navigation Bar. 

 

13.1 Archive Viewer File Menu 

Click File to open the Archive Viewer File Menu.   

13.1.1 Open Archive Directory 

Choose Open to change the folder location of the archive 

viewer. 

Search Filters 

 

 

Search Results 

 

 

 

Event Detail 

 

 

Page Navigation Bar 

Event Detail 

 

 

 

Page Navigation Bar 

File Menu 

Event Detail 

 

 

 

Page Navigation Bar 
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13.1.2 Export Archive Records 

Choose Export to open the Export window.  

• Export Location:  Type or Browse to a 

location on disk where a CSV file can be 

stored. 

• Record Selection 

o Export selected records:  Use this 

feature to only export the records 

that were selected in the archive 

viewer search results.  Records can be selected by checking the box in the first column of the 

search results window.

 

o Export Current Page:  Only export records that are on the currently selected page.  Each page 

will only have 100 results. 

o Export all pages:  This will export all of the results from the last archive viewer search. 

• Audio Export 

o No audio export: 

▪ Information about any audio transmissions will be recorded in the CSV file but the 

actual audio will not be exported. 

o Export individual audio files: 

▪ A WAV file for each audio transmission will be saved in the same folder you chose to 

save the CSV file. 

o Export combined audio file: 

▪ A single WAV file will be saved in the same folder you chose to save the CSV file.  This 

WAV file will contain each audio transmission file from the search results. 

 

Press OK to begin the export.  The CSV file will have the following columns: 

Some columns will be blank.  As the chart above shows, different record types will only fill in columns where 

there is data.   

 

 

 

Export Location 

Audio Export 

Record Selection 
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13.2 Search Filters Area 

The Search Filters Area of the Archive Viewer Window allows very flexible searching of the database and 

display of the search results using the features described below. 

13.2.1 Quick Filter Bar 

The Quick Filter Bar contains tools to easily find archive events based on day, time, user, radio channel, or 

event type. 

13.2.2 Preset Time Intervals 

The Preset Time Intervals allows various 

selections such as “Today”, “Yesterday”, 

“This Week”, “Last Week” and others.  To 

specify a Preset Time Interval, click the   button, and then choose an interval from the drop-down list 

 

13.2.3 Custom Time Interval 

Custom Start Time and End Time may be 

specified for time periods that are not in 

the Preset Time Intervals list.  To specify 

a Custom Time Interval, click the   button, choose Custom Interval from the drop-down list, and then 

complete the Start Time and End Time fields. 

 

13.2.4 Event Type(s) 

One or more Event Types may be selected 

as part of the search criteria.  Click the All 

button to quickly select all event types.  If 

a search is performed with no Event Type selected, the search will include all Event Types. 

Click the Notes Only button to search only for events that have Notes attached to them.  Notes are attached to 

an event by clicking the Note button    on the Recent History tab. 
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13.2.5 Custom Search Criteria 

Use the Custom Search Criteria box to 

enter specific details about the events to 

be found. Searchable items include 

Gateway name, Channel name, Zone name, Alias name, and Alias ID number.  The following are some 

guidelines for search criteria: 

• Separate each search detail with a space.   

• Any Terms vs. All Terms:  If Any Terms is selected, searching for Bob North will return all 

results where either Bob or North is found.    If All Terms is selected, searching for Bob North 

will return all results where Bob and North are found in a single record. 

• Search criteria are NOT case sensitive.  For example, a search for North is the same as 

searching for NORTH or for NoRtH. 

• Wild card character (*):  The wild card character can be used to search for zero or more 

characters after the end of a search item (and only at the end). Correct search criteria include 

Bob*, or B*.  Incorrect search criteria include B*b, or *ob. 

• Double quotes (“ “):  Searching for a phrase using double quotes, such as the Gateway name 

”Fire North” (including the space between the two words), will find the entire phrase within 

the double quotes. 

• Special characters:  Any special characters used in naming will be logged to the database.  

However, special characters cannot be used as search criteria. 

13.2.6 Search Examples 

Correct search criteria to locate Gateway name Fire North include: 

• Fire 

• North 

• Fire North (space between Fire and North) 

• North Fire (space between North and Fire) 

• “Fire” “North” 

• F* 

• F* N* (space between F* and N*) 

• “fire north”   

Incorrect search criteria include: Fire:North, Fir, Nor, “North Fire”, FireNorth, *orth, No*th. 

. 
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13.2.7 Search Button 

Click the Search button to perform a 

search for all parameters selected in the 

Search Filter Area. 

 

13.3 Search Results Area 

The Search Results Area will display the 

records that match the search criteria 

specified in the Search Filters Area. The 

various sections of the Search Results Area 

are described below.  

 

13.3.1 Records Found 

This parameter displays the number of Records Found that match the search criteria. 

 

13.3.2 Records Found List 

This section lists the Records found that match the search criteria. 

13.4 Event Detail Area 

The Event Detail Area lists specifics about the event that is selected in the Search Results Area, and will change 

depending if the selected event is a Voice Recording, Subscriber GPS Location, Text Message, or Geo-fence 

Event. 

13.4.1 Voice Recording Detail 

If the selected event is a Voice Recording, 

the Voice Play Tool will be displayed.   

Click the Play Button    to begin the playback of the selected Voice Recording.  Click the Speaker Button  

  to display the Audio Playback Level slider.  Click the “Save” link to save the audio as a WAV file. 
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13.4.2 Subscriber GPS Location Detail 

If the selected event is a Subscriber GPS Location, a Toolbar will include Zoom Tools, Map Type Tool, and Map 

Presets Tool.  In addition, a map will display subscriber details and location for the archived event.

  

13.5 Page Navigation Area 

Click  or  to view the 

previous or next page of events or click on 

a number to view that page.  
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14 TROUBLESHOOTING . . .  

14.1 What if One Radio Controller is Grayed-out?  

 

14.1.1 Example Screenshot 

  

14.1.2 Significance 

When one Radio Controller is darkened as indicated above, it could mean any of the following: 

• The network connection between the PC and the IP Gateway has been lost, indicated by “Can’t 

connect to Gateway”. 

• The IP Gateway is either turned off or is in the process of rebooting. 

• The Control Station radio is either disconnected from the IP Gateway, is turned off, or is in the 

process of rebooting, indicated by “Radio Disconnected”. 

14.1.3 Details 

Further detail about the connection to an IP Gateway is available by using the information in the Manage IP 

Gateways window as follows: 

o From the Options menu, choose Manage IP Gateways. 

One Radio Controller 

is grayed-out and 

not connected 
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o In the Manage IP Gateways window shown below, the Gateway Status will be indicated 

either as Connected or Not Connected.  In addition, the Ratio Status will be indicated as 

either “Connected” when its version is displayed, or Radio not connected. 

 

14.1.4 Corrective Actions 

Gateway Status is “Connected” and Radio Version is “Radio not connected” 

• Verify that the Control Station radio is powered on. 

• Verify that the Control Station radio is physically connected to the IP Gateway using the 

supplied cable. 

• Verify that a programming cable is NOT connected to the front mic connector of the Control 

Station radio.  If a programming cable is connected to the front mic connector, remove it, and 

then reboot the radio. 

 

Gateway Status is “Not Connected” and Radio Version is “Radio not connected” 

• Verify that power is connected to the IP Gateway. 

• Verify that the blue Power light on the front of the IP Gateway is illuminated. 

• Verify that the IP Gateway is accessible to the RadioPro software by using the Ping function 

from a Windows command prompt. 

• Look into the left-side vent holes of the IP Gateway and observe the red LED: 

o A non-blinking LED indicates that the IP Gateway has completed its rebooting sequence and 

is running normally. 

o A blinking LED indicates that the IP Gateway is rebooting.  Rebooting should be completed 

within 2 minutes.  If rebooting is not completed within 2 minutes, return unit to CTI 

Products for repair. 
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14.1.5 What if All Radio Controllers are Grayed-out? 

14.1.6 Example Screenshot 

  

14.1.7 Significance 

When all Radio Controllers are darkened as indicated above, it could mean any of the following: 

• Power has been removed from all IP Gateways. 

• The network connection between the PC and the IP Gateways has been lost. 

• A USB Hardware Key is not installed in the PC. 

• A Software License that matches the USB Hardware Key is not installed.  

• Temporary License has expired 

14.1.8 Corrective Actions 

Power has been removed from IP Gateways 

• Verify that the IP Gateways have power and are powered on. 

Network Connection has been Lost 

• Verify that the IP Gateways are accessible to the RadioPro software by using the Ping function 

from a Windows command prompt. 

• Verify that the IP Gateway is accessible to the RadioPro software by using the ICU.exe utility. 

A USB Hardware Key is not installed 

• Verify that the USB Hardware Key is installed.   

• Remove the USB Hardware Key and verify that the Windows alert tone for USB disconnection is 

heard. 

All Radio Controllers 

are grayed-out and 

not connected 
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• Re-insert the USB Hardware Key and verify that the Windows alert tone for USB connection is 

heard. 

Software License is not installed or is incorrect 

• Verify that a correct Software License is installed by using the following steps: 

o From the Options menu, choose Update License. 

o In the Update License window, verify that the USB Key Id matches the serial number 

engraved on the USB Hardware Key. 

o In the Update License window, verify that Connections is correct for the number of Radio 

Controllers. 

14.1.9 What if the Transmit Error Window is displayed? 

14.1.10 Example Screenshot 

 

14.1.11 Significance 

The above window may be displayed when a PTT button is activated, and if the microphone selected for 

transmitting is not connected.  This can occur if a microphone has been disconnected from the Dispatch PC, or 

if a microphone has been replaced by another microphone. 

14.1.12 Corrective Actions 

Determine if a microphone is connected 

• Determine if the Windows operating system recognizes a microphone connected to the PC by 

using the following steps: 

o In the Windows System Tray located at the lower-right corner of the Windows screen, 

right-click on the  tool, and then choose Recording devices.  The following Sound 

Recording properties window will be displayed. 
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o If the microphone does not appear in the above window, ensure that it is connected to the 

PC. 

o If the microphone appears in the above window, speak into the microphone and notice the 

response of the sound level indicator. The Sound Level Indicator should reach at least 50% 

with normal voice volume. 

Check Microphone Configuration in RadioPro Dispatch Client 

• With the microphone connected, it is possible that the configuration in the RadioPro Dispatch 

client is incorrect. Use the following steps to verify correct configuration: 

o From the Options menu, choose Audio Presets, and then verify that the correct preset is 

selected. 

o Retest the microphone function in RadioPro Dispatch.  If needed, ask the System 

Administrator to continue with the remaining steps. 

o From the File menu, choose Edit.   

o From the Options menu, choose Audio Presets, and then choose Config.   

o Click on the Devices tab to display the following window. 

 

o In the Devices tab shown above, verify that the Mic In parameter is correct for the Preset 

being examined. 

o Click Save Settings to exit the Audio Configuration window. 
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15 FEATURE AVAILABILITY 

15.1.1 Motorola MOTOTRBO Systems 

Depending on MOTOTRBO System Type, some features may not be available.  Use the following table to 

determine if a feature discussed in this document is not available. 

 

System Type 

 

Feature 

Analog 

 

Conv. 

Digital 

Cap + 

 

IP Site 

Connect 

Linked 

Cap + 

Connect 

Plus 

Voice Dispatch ✓ ✓ ✓ ✓ ✓ ✓ 

Text 

Messaging 
- ✓ ✓ ✓ ✓ - 

GPS Mapping - ✓ ✓ ✓ ✓ - 

ARS - ✓ ✓ ✓ ✓ - 

Private Call - ✓ ✓ ✓ ✓ ✓ 

Remote 

Monitor 

- 
✓ ✓ ✓ ✓ ✓ 

Remote 

Enable/Disable 

- 
✓ ✓ ✓ ✓ ✓ 

Telephone 

interconnect 

Rec/Mon 

 

- 
✓ ✓ ✓ ✓ ✓ 
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15.1.2 Kenwood NEXEDGE Systems 

Depending on NEXEDGE System Type, some features may not be available.  Use the following table to 

determine if a feature discussed in this document is available. 

 

    System 

Type 

 

Feature 

Analog  

Analog 

w/ 

FleetSyn

c 

Digital 

NXDN 

Digital 

NXDN 

w/ call ack. 

  

NXDN 

& LTR 

Trunking 

NXDN 

Trunking 

(MsgTrnkd) 

Voice Dispatch ✓ ✓ ✓ ✓ ✓ ✓ 

Text 

Messaging 
- ✓ ✓ ✓ ✓ ✓ 

GPS Mapping - ✓ ✓ ✓ ✓ ✓ 

Status Updates - ✓ ✓ ✓ ✓ ✓ 

Selective 

Calling 
- ✓ ✓ 

Not 

Currently 

Supported 
✓ 

Not 

Currently 

Supported 

Remote 

Monitor 
- ✓ ✓ ✓ ✓ ✓ 

Remote 

Enable/Disable 
- ✓ ✓ ✓ ✓ ✓ 
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16 INDEX 

A 

Add Note Button, 11, 26, 28, 31, 45 

Alias Name, 36 

Alias Table, 37 

All-Call Tool Button, 12 

All-Emergency Button, 12 

Archive Map, 43 

Archive Viewer Window, 43 

Assigned Channel, 36 

Audio Preset, 9, 10, 35, 53 

B 

Building a Dispatch Layout, 14 

C 

Call Alert Button, 25 

Call Select Tool Button, 11 

Change User, 33 

Connected, 34, 35, 50 

Connection Status Indicators, 19 

Control Station Radio, 13 

Creating a New Layout, 14 

CSV Format (comma separated values), 37 

Custom Time Interval, 45 

D 

Devices Tab, 53 

Diagnosing Volume Issues, 28 

Dispatch Settings, 28 

E 

Emergency, 12, 13 

Event Types, 45 

Notes Only, 45 

G 

Geo-fence, 27, 47 

Geo-fences, 47 

GPS Locate Tool Button, 25, 41, 42 

GPS Mapping, 39, 42 

Groups, 6, 11, 14, 35, 36, 37 

I 

IP Gateway, 6, 19, 34, 35, 49, 50, 51 

K 

Key 

USB Hardware, 51, 52 

L 

Levels Tab, 10 

License 

Export, 35 

Update, 35, 52 

USB Key, 35 

Login, 7, 33 

Logs, 38 

M 

Manage Devices Window, 13, 34, 49, 50 

Map Presets Tool Button, 41, 48 

Map Type Tool Button, 41, 48 

Menu 

File, 33 

Help, 38 
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Options, 9, 34 

O 

Overview, 6 

P 

Page Navigation Bar, 43 

Patch, 18 

Play Button, 47 

Pocket Mobile App, 6 

Preset Time Interval, 45 

Private Call, 39 

PTT Tool Button, 39, 42 

Q 

Quick Filter Bar, 45 

R 

Radio Check Button, 25 

Radio Controller, 9, 11, 14, 17, 18, 19, 49, 51, 52 

Radio Controller tab, 7 

Radio Disconnected, 19, 49 

Radio ID, 17, 18, 26, 35, 36 

Recent History tab, 7, 28, 31, 45 

Records Found, 47 

Remote Disable Button, 25 

Remote Enable Button, 25 

Remote Monitor Button, 25 

Reports, 12 

Restart Gateway, 35 

Restart Radio, 13, 35 

S 

Show Console, 38 

Snap-to-Road Route, 39 

Sorting, 26 

Subscriber Contacts, 35, 36, 37 

Subscriber List Sub-folder, 26, 42 

Subscribers tab, 24 

T 

Text Messaging, 6, 7, 41, 42 

Tool Bar, 9, 10, 11, 12, 13, 17, 39, 41, 43, 46, 48 

Tool Buttons, custom, 11, 12 

Toolbar, 9, 10, 11, 12, 13, 17, 39, 41, 43, 46, 48 

Toolbar Buttons, custom, 11, 12 

Transmit Error, 52 

V 

Version, 1, 38, 50 

Voice and Event Logging, 6, 12, 28 

Volume Adjustments 

Receive, 18 

Select Receive, 9, 11 

Unselect Receive, 9, 11 

Volume Info button, 28 

W 

Warning 

Disk Storage Caution, 12 

X 

XPR4550, 13 

Z 

Zoom, 41, 48 
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